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Welcome to Your Personal Cloud 2-Bay

Thank you for purchasing the Seagate Personal Cloud 2-Bay. You and everyone in your household can create
a centralized media library and safeguard your important files in one location.

With Seagate’s free apps, your content is safe and available to you no matter where you are.
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Seagate Dashboard—Create
backup plans to effortlessly
and automatically back up
content from your PC.
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Seagate Dashboard—Create
and maintain your media
library on your PC or Mac
with the Smart Copy
feature.

Seagate Mobile Backup—
Back up your mobile
devices to your Personal
Cloud 2-Bay.
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Backup Manager—Back up
to USB attached storage or
another network attached

storage device.

Il

System Requirements

Before you begin setting up your Personal Cloud 2-Bay, read through these instructions and specifications
and review the safety guidelines.

What's in the Box?

Make sure that you have these items. If not, contact Seagate Customer Support.

Seagate Personal Cloud 2-Bay 5/24/17
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Hardware Requirements

Your router must have one 10/100/1000 Ethernet port.

Software Requirements

e Windows® 10, 8.1, Windows 7, and Windows Vista®
e Mac OS® X v10.8 or later

Internet Requirements

® [nternet connection for activation and online file access and sharing

One of these web browsers:
Internet Explorer® 9.x or later
Firefox® 5.x or later

Chrome 11.x or later

Safari® 5 or later

Connect Your Personal Cloud 2-Bay

1. Using the supplied Ethernet cable, connect your Personal Cloud 2-Bay to your Wi-Fi router.

Seagate Personal Cloud 2-Bay 5/24/17
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2. Attach the power adapter to the Personal Cloud 2-Bay power port, and plug the adapter into a power
outlet.

While powering up, the LED on the top of the device quickly flashes white. When the LED is a solid white,
the device is ready to access on your network. For more information about the LED behavior, see LED
Behavior.

Seagate Personal Cloud 2-Bay 5/24/17
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Seagate Access and Personal Cloud Setup

Seagate Access is an account that you use to remotely access your Personal Cloud. Generally, the Personal
Cloud owner’s Seagate Access account is created automatically when first configuring the Personal cloud. The
owner then creates Seagate Access accounts for other users.

How do | use my Seagate Access account?

You can use your Seagate Access account with the following:
e Personal Cloud app-Available using any web browser.[2
e Seagate Media app-Available for Android and iOS mobile devices.

Access Personal Cloud content using a web browser

You can access your Personal Cloud using a web-based portal that allows you to manage your devices,
account, users, and content—at home, in the office, or anywhere with an internet connection.

Example: You have important work files that you backed up to your Personal Cloud at home. You open a web
browser and login to your Personal Cloud, which allows you to copy the important files to your work
computer.

You can access the Personal Cloud app using your favorite web browser.

1. Open aweb browser and go to personalcloud.seagate.com.

2. Sign in with your email address and password.?

3. Your NAS OS devices are listed. Click on the Personal Cloud you would like to access.?

Use the Seagate Media app to access content on your mobile
device

Seagate Media is an app for viewing and listening to media files on mobile devices. Install Seagate Media on
your Android and iOS devices to access movies, photos and music stored on your Personal Cloud.

Example: You are at a friend’s home and you want to show pictures from your family vacation. Since the
photos are stored on your Personal Cloud at home, you can access them remotely with your Seagate Access
account. Seagate Media is installed on your Android or iOS phone and linked to your Seagate Access
account. To show the photos, you open Seagate Media and choose your Personal Cloud.

Personal Cloud Owner Setup

Seagate Personal Cloud 2-Bay 5/24/17 12
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When you set up your Personal Cloud 2-Bay, you also create the owner account. The owner adds users,
manages the device’s services, such as iTunes, and manages device settings, such as power management.

If you followed the quick start guide and were successful setting up your device and adding your owner
account, you can start adding users.

Set Up Your Owner Account

1. Access your Personal Cloud.

® PC or Mac—Using a web browser, go to personalcloud.seagate.com.

e PC only—In File Explorer under Networks, click PersonalCloud. Open the Public folder and then
double-click Personal Cloud.

® Mac only—In Finder under Shared, click PersonalCloud. Open the Public folder and then double-click
Personal Cloud.

p’ Note: If your computer does not detect your Personal Cloud, go to Seagate Support.

2. Accept or change your storage settings.

By default, your Personal Cloud 2-Bay is configured for maximum protection. This means that all of the
data you copy to your device is stored on one disk, and a copy of that data is stored on the second disk.
This configuration provides the greatest protection, but does reduce the total capacity of storage on your
drive. In the event of a disk failure, you can replace the failed disk and continue to use your Personal
Cloud 2-Bay.

To use all of storage available on your device, select Maximum capacity. This option allows you to use all
available storage, but offers no data protection.

& Note: If you change the configuration of your Personal Cloud 2-Bay after you have created

your media library or backed up computers in your home, you will lose your data. Copy all
data to another device before you reconfigure your device to a different storage setting.

3. Enter your email address and create a password.

If you have registered with Seagate before (for example, you already have a Seagate Access account),
you can use the same email address and password.

Your Personal Cloud 2-Bay creates your:

e Username, which allows you to access your private folder, manage users, and manage device settings
e Private folder, where you can store personal content

Seagate Personal Cloud 2-Bay 5/24/17 13
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e Seagate Access account, which allows you to access your Personal Cloud 2-Bay remotely and enable
remote access for other users

4. A message is sent to your email account with the confirmation link or code needed to activate your
Seagate Access account.

Note: Check your spam folder if you don'’t find an email in your Inbox.

Note: You also need to confirm your Seagate Access account before you can give other
users remote access.

o

Click Finish.

6. You're now given the option to use the Setup Assistant to show you how to use your Personal Cloud 2-
Bay and help you configure your services.

7. The Personal Cloud 2-Bay management page opens. Click the Apps icon to see all available apps:

g2z Hello v Personal Cloud

PERSC

T ® © D

Device Manager Download Manager Backup Manager

SHARE

NONCNO)

App Manager Assistant Filebrowser

IFTTT @

IFTTT Seagate Media

Device Manager. Manage users and manage your device.

Download Manager. Download files to your device.

Backup Manager. Manage your backups from your computer, cloud service, and device.

App Manager. Add new features to your device.

Assistant. Take a tour of what your Personal Cloud has to offer.

Filebrowser. Access your files in your web browser.

Seagate Media. Enjoy your media library on your mobile devices.

IFTTT. Connect your Personal Cloud to your IFTTT account. For details, see the IFTTT for Seagate
Storage User Manual.

Seagate Personal Cloud 2-Bay 5/24/17
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Apps with arrow overlays are not installed. Click the app to install it.

You are now ready to:

e Add user accounts
Begin building your media library
Protect your important documents
Manage your Personal Cloud 2-Bay

Seagate Media Setup

Follow the directions below for installing Seagate Media.

& Important info for users: Your Seagate Access account must be associated with your Personal
e Cloud before you use Seagate Media to access media. The owner of your Personal Cloud should
have sent you an invitation email with instructions on how to link your account to the Personal
Cloud. Contact the owner of your Personal Cloud if you do not know your Seagate Access
credentials.

1. Install Seagate Media on your Android or iOS mobile device. Seagate Media is available at the Google
Play Store and the iOS App Store. For further details, see Seagate Media.?

2. Open Seagate Media on your mobile device.Z

3. Tap the Moreicon.?

e Android Moreicon:
e iOS Moreicon: see

Tap Settings.(

Tap Remote Access.[?

Tap Seagate Personal Cloud.

Enter your Seagate Access account credentials.?

NOo u s

For instructions on how to use Seagate Media to access, play and organize media stored on your Personal
Cloud, choose the user manual for your mobile device:

e Seagate Media for Android.?

® Seagate Media for iOS.2

Seagate Media for Windows and Seagate Access
The Seagate Media app for Windows 8, Windows 8.1 and Windows RT does not support Seagate Access at
this time. Instead, access your device by going to PersonalCloud.seagate.com.

Seagate Personal Cloud 2-Bay 5/24/17
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Adding and Managing Users

The Personal Cloud 2-Bay owner can add and manage users.

Access your Personal Cloud

Access using a web browser (PC and Mac)

1. Openaweb browser and go to PersonalCloud.seagate.com.
2. Login with your email address and password.
3. Your NAS OS devices are listed. Click on the Personal Could you would like to access.

Access using Windows or File Explorer (PC only)

Open your Windows or File Explorer.

Under Networds, click PersonalCloud.

Open the Public folder, and then double-click PersonalCloud.
Enter your Personal Cloud username and password.

Cali e A o

Access using the Finder (Mac only)

Open a Finder window.

Under Shared, click PersonalCloud.

Click Connect As... .

Select Registered User.

Enter your Personal Cloud username and password.

SAEESIR I .

Open the Users page

1. Click the Apps icon, and then click on Device Manager.

Seagate Personal Cloud 2-Bay 5/24/17
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Device Manager

2. Click Users.

Add users

As the owner, you can invite people at home and outside of your home network to use your Personal Cloud
2-Bay.
1. Open the Users page.

& Note: If you want to enable remote access and you haven't confirmed your Seagate Access
account, do so now by clicking Confirm Email.

2. Click Add user.

You can add three types of users:

® Local and remote—A user who has access to your home network and can also have remote access to
your Personal Cloud when away from home.

e Local only—A user who can only access the Personal Cloud at home on the local network. You can
give this user remote access later if needed.

e Remote only—A user who can only access your home Personal Cloud remotely. You can give this user
local access later if needed.

3. Complete the New User form.

An email with instructions is sent to the new user. Users should check their Spam folder if they have not
received their email invitation. The code is valid for 72 hours. The owner can send a new invitation if the
code expires.

Seagate Personal Cloud 2-Bay 5/24/17
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i Important info: Your Personal Cloud can have a maximum of 10 users.

Manage remote access for an existing user

The owner can manage remote access on a user-by-user basis. Remote access allows users to access
content while away from home.
You can also control remote access for all users.

To manage remote access for a specific, existing user:
1. Open the Users page.

& Note: If you want to enable remote access and you haven't confirmed your Seagate Access
account, do so now by clicking Confirm Email.

2. Click the dot under Seagate Access to the right of the username.

Seagate Access Description
Status
& Seagate Access is on
O The owner has invited a user to create a Seagate Access, but the process is not
complete.*

Seagate Access is off

* A yellow dot indicates a pending status. You have invited the user to create a Seagate Access account and
the Personal Cloud 2-Bay is waiting for the user to complete the process.

Edit a user

Only the Personal Cloud 2-Bay owner can change a user’s username and email address.
1. Open the Users page.
2. Click the item you want to change.

e Username—Changing the username also changes the user’s private folder name.

e Password—Changes only the user’s private folder password. The option to change a user's password
is not available if the user has a Seagate Access account. The user can change her password by logging
in to the Personal Cloud (see Passwords).

e Email address—The email address is the user’s Seagate Access ID, which is used to remotely access
your Personal Cloud.

Delete a user

Seagate Personal Cloud 2-Bay 5/24/17
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The Personal Cloud 2-Bay owner can delete all user accounts. Deleting a user account also deletes the user’s
private folder and its contents.

If the user has created backup plans through the Backup Manager, the backups are also deleted. For more
information, see Backups. Open the Users page
1. Open the Users page.

2. Place the cursor to the right of the user's row and click Edit.
3. Select Delete.

Seagate Personal Cloud 2-Bay 5/24/17
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Public and Private Folders

Your Personal Cloud 2-Bay has a Public folder that anyone can use and a private folder where each local user
can store personal content that others cannot see.

What's the difference?

Everyone on your home network can access the Public folder. Anyone who has been given a Seagate Access
account to the storage device can also access the Public folder. Use the Public folder for files you want to
share and for your centralized media library.

A private folder is created for each user account and is password protected. Use your private folder to back
up content that you don't want to share with others.

Cafe

Access with Access with Seagate
Dbl Access account
(Mom)

(email address)

Public

Jim

Seagate Personal Cloud 2-Bay 5/24/17 20



Which folder to use
Public folder

Create your media library in the Public folder and copy any data that you want to share to the Public folder so
that you and others can access it. See Media Library.

Private folder

Back up your content to safeguard against computer malfunctions. Content backed up to the Public folder can
be viewed by anyone who has access. No one but you can view content backed up to your private folder.
You can back up your computer and mobile devices using Seagate Dashboard software and Seagate Mobile
Backup apps. You can also back up your backups by creating backup and sync plans in the Personal Cloud 2-
Bay with Backup Manager.

For information on Seagate Dashboard and Mobile Backup apps, visit the Seagate Dashboard page.

For information on backing up your backups, see Backing Up Your Content.

Seagate Personal Cloud 2-Bay 5/24/17
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Media Library

You can use your Seagate Personal Cloud 2-Bay to centralize your media. Copy media to the library and
stream its content to devices in your home and to mobile devices when you're away.

Create and maintain media in the Public folder

Music, movies, and photos—you and other household members may have media files on multiple devices.
You can consolidate your household media in one place on your Personal Cloud 2-Bay for sharing and easy
maintenance.

Copy your media library to the Public folder on your Personal Cloud 2-Bay. You can easily stream the content
on your other devices using the Seagate Media app. Learn more about the Seagate Media app.

Before you copy your media to your Personal Cloud 2-Bay from your computer, Seagate recommends that
you connect your computer directly to your router instead of using a Wi-Fi connection. Wi-Fi speeds are
not ideal for copying large quantities of files.

To copy You need to
content
from your

Computer  Install Seagate Dashboard on your computer, and create a Smart Copy plan that continuously
updates your media library on your Personal Cloud 2-Bay.

Mobile Install Seagate Media on your mobile device from your app store, and set up Auto Upload to
device automatically back up photos and videos to your Personal Cloud. Configure Auto Upload in
the Seagate Media app's Settings menu.

External Connect the device to a USB port on your Personal Cloud 2-Bay and use Filebrowser to copy
device content. For instructions, see Filebrowser. You can also configure regular backups to and from
the external device. See Backup Manager for details.

Provide public access to selected media in your
private folder

The Public folder is a convenient location for files that everyone on your home network needs to access. A
user can also provide access to selected folders in their private user folder. This allows other users of the
Personal Cloud device (and anyone on the home network) to view and play content using Seagate Media. To
provide Seagate Media access to a folder:

1. Click the Apps icon, and then click on Filebrowser.

Seagate Personal Cloud 2-Bay 5/24/17
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%X

™)

Filebrowser

2. Open your private user folder.
3. Navigate to the folder you want to provide with Seagate Media access.

4. Click the folder to select it, and then clik Add to Seagate Media. A dialog box appears.
5. Click Save.

A Seagate Mediaicon (®) appears next to any folder you've provided access to.

To remove Seagate Media access:
1. Click the folder to select it, and then click Remove from Seagate Media.

Stream media content

You can stream your media from the Public folder on your Personal Cloud to a variety of devices throughout
your home. You can also stream media to your mobile devices when you're away from home.

Stream media at home

To stream You need to
content to your

Seagate Personal Cloud 2-Bay 5/24/17
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Apple TV 1.

w

v

Chromecast 1.

A

Install the Seagate Media app on your mobile device.

Connect your mobile device to your Personal Cloud 2-Bay.

(Your mobile device and Personal Cloud 2-Bay must be on the same home
network.)

Launch the Seagate Media app.

Use the Apple TV remote to select the local network from the list or to enter local
network's name if the network is hidden.

(Your Apple TV must be on the same home network as your Personal Cloud and
mobile device.)

Enter your password if requested. The Apple TV connects to the router.

Enable AirPlay.

Swipe up from the bottom of your mobile device to access Control Center. Select
your Apple TV.

p’ Tip: Make sure Mirroring is off for Videos and Music.

Select a movie or songin the Seagate Media app and click Play.
The AirPlay icon appears on the far right, beside the "Forward" button.
The movie or song plays on the TV connected to your AirPlay device.

Configure Chromecast on your TV and Wi-Fi per the manufacturer's instructions.
Install Seagate Media on your mobile device.
Tap the cast icon and choose video, photo, or music to start casting.

DLNA Certified = The DLNA service, an industry-wide standard for sharing data over a home network; is
device turned on by default on your Personal Cloud 2-Bay.

1.

2.
3.

Seagate Personal Cloud 2-Bay

Connect your DLNA Certified device and your Personal Cloud 2-Bay to the same
Wi-Fi network (when required).

Consult your DLNA Certified device's instructions.

Generally, DLNA provides a menu showing available devices. Select your Personal
Cloud 2-Bay.

Your DLNA Certified device loads the content it is able to play from your Personal
Cloud 2-Bay.
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iTunes Turn on the iTunes service.

1.
2.

w

o u»

LG TV

SAEESIR .

In the Device Manager, click Services.

Place your mouse over the iTunes service. Click the Edit menu that appears, and
then click Start.

Start iTunes on your computer.

Open Preferences. (On a Mac keyboard, press command+comma. In iTunes on your
PC, select Preferences from the Edit menu).

Click the General tab and ensure that Shared Libraries is checked.

Open the menu sidebar (View > Show Sidebar)

Under Shared, select PersonalCloud

To learn how to copy your iTunes library to your Personal Cloud 2-Bay, visit the
Seagate Personal Cloud 2-Bay support page.

Turn on your LG TV.

Connect your LG TV and your Personal Cloud 2-Bay to the same Wi-Fi network.
Install the Seagate Media app on your mobile device.

Connect your mobile device to your Personal Cloud 2-Bay.

Tap the cast icon and choose video, photo, or music to start casting.

Roku There are two ways to enjoy content on Roku.

1.

2.

Install Roku Media Channel from the Roku app store and connect to your Personal
Cloud 2-Bay through the app.

Install the Seagate Media app on your mobile device. Connect your Roku device
and Personal Cloud 2-Bay to the same Wi-Fi network.

Tap the cast icon and choose video, photo, or music to start casting.

Samsung Smart  Install Seagate Media from the Samsung app store and connect to your Personal Cloud
TV 2-Bay through the app.

Stream media away from home

To You need to

remotely
access
content
to your

Seagate Personal Cloud 2-Bay
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iOS or Install the Seagate media app.
Android
media

device Seagate recommends that you install the Seagate Media app on your mobile device for

optimal access and viewing of your media. The Seagate Media app contains a remote access
module that allows you to sign in to your Seagate Access account and access your Personal
Cloud 2-Bay media library.

& Note: You must create your Seagate Access account on your Personal Cloud 2-Bay
before you can sign in through the Seagate Media app.

Remotely access media content

You can remotely access media on your Personal Cloud 2-Bay using your Mac or PC computer.

To remotely access You need to
content on your

Mac and PC computer 1. Open aweb browser and go to PersonalCloud.seagate.com.

Log in with your email address and password.

3. Your NAS OS devices are listed on the page. Click on the Personal Cloud
you would like to access.

4. The Filebrowser app is launched automatically, allowing you to view and
access your content.

A
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Backing Up Your Content

Seagate provides several ways to protect your content. You can back up your:

Personal Cloud

Computers

Mobile devices

Cameras

USB storage

Cloud storage

Network storage (e.g. another Personal Cloud, Seagate network storage or third-party network storage).

Before backing up a computer to your Personal Cloud, Seagate recommends that you connect the computer
directly to your router instead of using a Wi-Fi connection. Wi-Fi speeds are not ideal for copying large
guantities of files. After you have created your first backup, you can back up future changes over Wi-Fi.

Back up your devices

To back up content from your  You need to

PC Install Seagate Dashboard on your computer, and create a backup plan.
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Mac

Mobile device

Personal Cloud

Cameras

USB storage

Cloud storage

Network storage (e.g. another
Personal Cloud, Seagate

network storage or third-party
network storage)

Seagate Personal Cloud 2-Bay

Set up a Time Machine plan.
1. Open Time Machine preferences.

2.
3.

i

Click Select Disk.
Find your Private folder name.

ZhangLi |

on “PorsonalCloud”

Select the folder and click Use Disk.

Enter your Personal Cloud username and password.

Click Connect.

Wait for a minute or two to connect. Your backup will start
automatically.

Install Seagate Dashboard on your PC or Mac, and sign in to the
Mobile Backup section in Dashboard.

Install the Seagate Mobile Backup app on your mobile device from
your app store and create a backup plan as instructed in the app’s
help.

Install Seagate Media on your mobile device from your app store,
and set up Auto Upload to automatically back up photos and videos
to your Personal Cloud. Configure Auto Upload in the Seagate Media
app's Settings menu.

See Backup Manager.

See Backup Manager for backups and Filebrowser for easy copying and
ingest.

See Backup Manager.

See Backup Manager.

See Backup Manager.

5/24/17
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Downloading Large Files

You can use your Personal Cloud 2-Bay as an efficient way to download large PDF, torrent, or binary files to
your Personal Cloud.

Access your Personal Cloud

Access using a web browser (PC and Mac)

1. Open aweb browser and go to PersonalCloud.seagate.com.
2. Login with your email address and password.
3. Your NAS OS devices are listed. Click on the Personal Could you would like to access.

Access using Windows or File Explorer (PC only)

Open your File Explorer.

Under Networds, click PersonalCloud.

Open the Public folder, and then double-click PersonlCloud.
Enter your Personal Cloud username and password.

b

Access using the Finder (Mac only)

Open a Finder window.

Under Shared, click PersonalCloud.

Click Connect As... .

Select Registered User.

Enter your Personal Cloud username and password.

vk N

Open the Download Manager

Click the Apps icon, and then click on Download Manager.
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O,

Download Manager

Download large files

You can download PDF, binary, and torrent files to your Personal Cloud 2-Bay.

o

1. Open the Download Manager.
2. Click Jobs.

3.
4
5

If the service is off, click the slider on the right to turn the service on.
. Click Add download.
. Enter the source.
® [f the file is on the Internet, select URL and enter the URL address.
e |[f the file is on your computer and it is a torrent file, select Local and browse for the file.
Enter the destination folder on your Personal Cloud 2-Bay
. Click Save.

Manage download settings

You can change the number of downloads that you can request at the same time and change the download
and upload rates.

O

Seagate

pen the Download Manager and click Settings.
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Passwords

Account types

The owner creates one of the following types of accounts for herself and users:
e Local access only.
® |oginto your Personal Cloud on the home network.
e Local and remote access.
® |oginto your Personal Cloud on the home network.
e |oginto your Personal Cloud at remote locations using your Seagate Access account. Seagate Access
is compatible with Seagate Media.
e Remote access only.
® [oginto your Personal Cloud from remote locations using a Seagate Access account. Seagate Access
is compatible with Seagate Media.

For further information regarding Seagate Access, see the Seagate Access and Personal Cloud Setup.

Changing passwords

Owner password
Account Access Change password
type
Local The owner enters the Log into the Personal Cloud and go to Device Manager > Users.
access password to connect to
only her private folder on the

home network.

Seagate = The owner enters the To keep passwords consistent between your Personal Cloud and
Access password to connect to Seagate Access, click on the Down Arrow icon next to Hello [your
account  her private folder onthe  username] and select Manage passwords. A pop-up window opens

(local home network as wellas  allowing you to change local and remote passwords. It's
and to connect from remote recommended that you change both at the same time to keep
remote  locations. things simple.
access)
User password

The user or the owner can change a user’s password.
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Account Access Change password

type
Local The user enters their Log into the Personal Cloud and go to Device Manager > Users.
access password to connect to
only their private folder on the

home network.
Seagate = The user enters their To keep passwords consistent between your Personal Cloud
Access password to connect to and Seagate Access, click on the Down Arrow icon next to Hello
account  their private folder on the [your username] and select Manage passwords. A pop-up
(local home network, or to window opens allowing you to change local and remote
and remotely login to the passwords. It's recommended that you change both at the same

remote  Personal Cloud usingaweb  time to keep things simple.
access)  browser.

Remote @ The user enters their Log into the Personal Cloud on the home network and go to
access password to connect to Device Manager > Users.

account  their private share remotely

only using a web browser.

Local and remote access

When first creating an account, the password is synchronized between the Personal Cloud and Seagate
Access. To keep passwords consistent between the Personal Cloud and Seagate Access, update passwords
on the Personal Cloud on the home network as instructed below.

Owner

The owner or admin of the Personal Cloud can change their own password, as well as another user's local
password.

Note: The owner cannot change the remote access password of a user's remote access account. That user
will need to change their own remote access password.

Owner changing their own password

1. Loginto the Personal Cloud.

2. Click the Down Arrow icon next to Hello [your username].

3. Select the Manager passwords option.

4. A pop-up window opens allowing you to change local and remote passwords for the owner's account. It's
recommended that you change both at the same time to keep things simple.

Owner changing a local user's password
1. Loginto the Personal Cloud.
2. Click the Apps icon, and then click on Device Manager.
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Device Manager

3. After the page loads, select Users.
4. Under the Device password list, select the password of the user you'd like to update.
5. Enter a new password for the user.

Note: The user will now need to use this new password for accessing the Personal Cloud locally.

User

1. Loginto the Personal Cloud.

2. Click the Down Arrow icon next to Hello [your username] and select the Manage passwords option.

3. A pop-up window opens allowing you to change local and remote passwords. It's recommended that you
change both at the same time to keep things simple.

Resetting a forgotten password

The sign-in page for your Personal Cloud includes the option to reset a forgotten password. Resetting the
password on the sign-in page only updates the password on your Personal Cloud. It does not update the
password for your Seagate Access account. Therefore, your password will not be synchronized between
your Personal Cloud and Seagate Access. Review the options below to learn how to manage a forgotten
password.

Resetting the password: Personal Cloud

If you cannot recall your password, you have the option to reset it in two applications to maintain
consistency:

e Personal Cloud sign-in page

e Personal Cloud web app
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Reset on the Personal Cloud

1. Go to the Personal Cloud sign-in page.
2. Click Forgot password and complete the reset.

Reset your Seagate Access account password with the Personal Cloud web app

Go to PersonalCloud.seagate.com.

Click the Forgot password link.

Enter the email address associated with your remote access account.

An email will be sent to your email account. Open the message and click the Reset Password link.
Enter your new password and click Reset.

A message appears confirming that your password has been changed.

I S i
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Owner Administration

Your Personal Cloud 2-Bay has been configured with standard default settings. If you're the owner, you can
modify settings such as the device name, time zone, and the services used.

Access your Personal Cloud

Access using a web browser (PC and Mac)

1.
2.

Open aweb browser and go to PersonalCloud.seagate.com.
Login with your email address and password.

3. Your NAS OS devices are listed. Click on the Personal Could you would like to access.

Access using Windows or File Explorer (PC only)

1.
2.
3.

Open your File Explorer.

In the left window pane, click on Networks.

Under Networks, click PersonalCloud.

Note: If you do not see the Personal Cloud listed under Networks, make sure your Wireless connection
type is Private.

Open the Public folder, and then double-click PersonalCloud.

Enter your Personal Cloud username and password.

Access using the Finder (Mac only)

CAEESIR .

o

Open a Finder window.

Under Shared, click PersonalCloud.

Click Connect As... .

Select Registered User.

Enter your Personal Cloud username and password.

Note: Make sure you use the Personal Cloud username and password. Some Mac systems will autofill the
field with your Mac username. Remove the default Mac username and enter your Personal Cloud
username.

Open the Public Folder and then double-click Personal Cloud.

Enter your Personal Cloud username and password.

Open the Device Manager

1.

Click the Apps icon, and then click on Device Manager.
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LED Behavior

Your Personal Cloud 2-Bay LED is on the top of your device. When your device is starting up for the first
time, the LED blinks white. After 8 - 10 minutes, your device is ready to access over your Wi-Fi network.

p’ Note: Your LED might continue to blink, as the hard disk drive is initiating the software.

If you reset your device, the LED begins blinking red, and then blinks white.

Personalize your Personal Cloud 2-Bay

You can personalize your device by changing its name, the language, time zone, and more.
1. Open the Device Manager.
2. Click Settings and make your changes.

You can change settings that have an on and off button or display a pencil icon when you place the cursor
over the setting. Click the pencil icon to make a change.

¢ Note: If you want to change the time zone, and you have enabled Synchronization, turn it off
before changing the time zone and then turn it back on.

Changing Device Services

Your Personal Cloud 2-Bay is preconfigured with many services that allow you to stream to a TV, use iTunes,
download and upload files to your computer, and manage remote access.

Start and stop a service

1. Open the Device Manager.

2. Click Show advanced settings, and then click Services.

3. Move the cursor over the service until the Edit button appears on the right.
4. Click Edit and select Start or Stop.

Re-index a media service

If media files appear to be missing from your media service, you can re-index the service to take an
inventory of available multimedia files.

1. Open the Device Manager.

2. Click Show advanced settings, and then click Services.
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3. Move the cursor over a media service until the Edit button appears on the right.
4. Click Edit and select Re-index.

Control remote access for all users

By default, anyone with a Seagate Access account on your Personal Cloud 2-Bay can access content on the
storage drive while away from home. You can disable this ability for all accounts. If you want to disable this
ability for a specific user, see Manage remote access for an existing user.
1. Open the Device Manager.
2. Click Show advanced settings, and then click Services.
3. Move the cursor over Seagate Access until the Edit button appears on the right.
4. Click Edit and select Enable remote access or Disable remote access.
A green circle indicates that the service is enabled.

Conserve power usage

You can save energy by turning off hard drives. When you turn off the hard drive, it still remains active to
receive network commands from other devices.

1. Open the Device Manager.

2. Click Show advanced settings, and then click Power.

3. To turn the hard drive off after a specified interval, select a value from the pull-down menu.

Connect your device to an uninterruptible power
source

Connecting your Personal Cloud 2-Bay to an uninterruptible power source (UPS) ensures a continuous power
supply.

1. Confirm that no one is accessing your Personal Cloud 2-Bay and power it off.

2. Connect a supported UPS device to a USB port on your Personal Cloud 2-Bay.

& Note: If you plan to schedule frequent backups to and from an external device, you might
want to connect the UPS to the USB 2.0 port on your device. The USB 3.0 port provides
greater transfer speeds.

3. Power on your Personal Cloud 2-Bay.

4. Open the Device Manager.

5. Click Show advanced settings, and then click Power.
6. Set the battery threshold level.

If your Personal Cloud 2-Bay reaches the threshold, it will automatically enter stand-by mode.
The UPS's status is provided within UPS Management:
@—The power cable is supplying power.

—The power cable is not supplying power.
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Important info: Seagate cannot guarantee that all UPS devices are compatible with your Personal
Cloud 2-Bay UPS management.

Monitoring

Monitoring provides a summary of your Personal Cloud 2-Bay:
e System. Review the overall health, the CPU and RAM consumption, and processes.

If you see anissue with the temperature, check the placement of your NAS to make certain that it is not
receiving an abnormal amount of heat from external sources (e.g. sun from a window, heating duct,
exhaust from other electronics, etc.). If you receive a drive error, select the Drive tab to review the

status of the hard drives.
e Drive. Review basic information for each hard drive, including the model number, capacity, temperature,

and SMART status. SMART stands for Self-Monitoring, Analysis and Reporting Technology. SMART status
should be used for informational purposes only, specifically when diagnosing hard drives. To run a
SMART test, select Autotest.

Notifications

You can monitor device activities, such as when a user was added and when the drive synchronized.

1. Open the Device Manager.
2. Click Show advanced settings, and then click Notifications.
You can filter notifications based on warning, errors, or show all notifications. You can also download the

system log.

Storage

You can check how much storage is available on your Personal Cloud 2-Bay and format your drive.

1. Open the Device Manager.
2. Click Show advanced settings, and then click Storage.
e Overview. Review the total device storage and the status of internal and external volumes (USB

attached devices).
e Network Drives. Format (erase all data) but keep the volume or Delete (remove the volume).

Important info: Formatting your drive erases all data. Before formatting the drive, back up your
data to another drive.

To learn how to reformat your drive, review the support article.

Network Settings
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Usually, you do not need to change your Personal Cloud 2-Bay network settings. If you are having issues with
network connectivity, changing the settings might solve the problem.

& Note: Changing network settings requires some understanding of networking and your specific
setup.

Change the IP configuration

By default, the IP configuration uses DHCP, a standard networking protocol that dynamically selects IP
addresses for interfaces and services. If you are having issues with network connectivity, you might want to
use a fixed IP address.

Manually changing your IP address is an advanced feature. The instructions below should only be followed if
you know the IP address supported by your home network. You can lose connection with your Personal
Cloud 2-bay by adding an incompatible IP address.

1. Open the Device Manager.

2. Click Show advanced settings, and then click Network.

3. On the Connections tab, click Edit.

4. Choose IPv4 or IPv6 based upon the IP address supported by your router. Most devices use IPv4.

5. Click the pull-down menu and choose Manual.

6. Enter the IP address, Subnet mask and Default gateway supported by your router.

7. Click Save.

Configure a proxy server

A proxy server acts as an intermediary between computers and the Internet. It allows the computers on your
network to make indirect network connections to other network services. Using a proxy server:

e Hides the IP address of a computer so that you can surf anonymously

e Bypasses security restrictions and filters to access blocked websites easily

& Note: Your router must have a proxy server to complete these steps.

s
1. Open the Device Manager.
2. Click Show advanced settings, and then click Network.
3. On the Proxy tab, select Proxy server in the drop-down menu.
4. Enter the proxy server address and the name and password if authentication is required.
5. Click Apply.

Configure port forwarding
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Port forwarding makes your Personal Cloud 2-Bay on your network accessible to other network attached
storage devices on the Internet, even though your Personal Cloud 2-Bay is behind a router. Automatic port
forwarding is enabled by default, and the port numbers are the same for your Personal Cloud 2-Bay and
router ports.

If you need to change the router port number for services, confirm that the ports are available on your
router. Additionally, you must confirm that your router is compatible with UPnP-IGD/NAT-PMP protocols.
See your router's user manual for details.

1. Open the Device Manager.

2. Click Show advanced settings, and then click Network.

3. On the Port Forwarding tab, move the cursor over the service until the Edit button appears on the right.
4. Click Edit, and then click Enable.

Reset your Personal Cloud 2-Bay

You can reset your device. A reset is not data-destructive. Performing these steps resets the network
settings and requires you to go through the initial setup process again. Your data is moved to a folder called
Recovery in the Public share.

The reset button is inside the casing on the back of your Personal Cloud 2-Bay.

1. Power off your Personal Cloud 2-Bay using the power button on the back of the device.

2. Insert a paper clip or slim object into the hole on the back of your Personal Cloud 2-Bay and press down
the reset button. Do not release the reset button.

Power on your Personal Cloud 2-Bay.

Wait for a minimum of 20 seconds, and then release the reset button.

5. The LED will blink red. Wait while the device resets to factory settings.

Ea

i Important info: Do not turn off the device while the LED is blinking red.

6. Wait for the LED on the top of the device to show a steady, non-blinking white light.
7. Setup your device.
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Hard Drive Maintenance

If a drive on your Seagate Personal Cloud 2-Bay fails, follow the directions below to replace it with a new
hard drive. Contact Seagate customer support for hard drive replacement if your device is within the
warranty period.

Your content after a failed hard drive

The availability of your content following drive failure depends upon how the device is configured.
o Maximum protection: Your content is safe on the healthy drive. The content must be copied for data
mirroring after the failed hard drive is replaced.
e Maximum capacity: Unfortunately, all content is lost following a drive failure. Additionally, the device
must be configured after the failed hard is replaced.

Important info: Refer to the warranty before performing hardware repairs or maintenance not
described in this manual.

Precautions

Remove a hard drive
Install a hard drive
Create a new volume

Precautions

e Except for replacing a hard drive, performing maintenance within the enclosure is not supported and can
void your product's warranty.

e During operation, the drives should remain in place for optimal airflow.

e Observe all conventional ESD precautions when handling the Personal Cloud 2-Bay’s parts. Avoid contact
with backplane components and module connectors, etc.

e Replace an existing or faulty hard drive with a hard drive of equal capacity.

e When handling hard drives, make sure that they are placed (and stored) on a cushioned surface.

Remove a hard drive

Disconnect power from the device before removing a hard drive.
1. Push the button on the back of your Personal Cloud 2-Bay.
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2. Remove the cover from the enclosure.

3. Remove the two screws that hold the disk in place.
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4. Pull the disk forward to disconnect it from its plug and then lift the disk up to remove it from the
enclosure.

Install a hard drive

Disconnect power from the device before installing a hard drive.
1. Attach the screws provided with your Personal Cloud 2-Bay to one side of the drive.
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2. Guide the hard drive so that the rear screw fits into its slot, and then slide the drive into its plug.

3. Fix the screws to the outside holes.
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4. Replace the cover, snapping it into place.

Maximum protection: repair

If your storage is configured as Maximum protection, you must repair the volume to copy content to the new
drive for redundancy.
1. Access your Personal Cloud.

e PC—In Windows or File Explorer under Networks, click PersonalCloud.

® Mac—In Finder under Shared, click PersonalCloud.
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p’ Note: If your computer does not detect your Personal Cloud, go to Seagate Support.

Open the Public folder and then double-click Personal Cloud.

Sign into your Personal Cloud 2-bay.

On the Network Drives page (lower left), click Manage. Do not click on the Summary page.
Choose Repair and then click Next.

Select the new hard drive and then click Next.

Review the summary page and then click Finish.

Choose Yes to configure the device.

©NO Uk N

Maximum capacity: create a new volume

If your storage is configured as Maximum capacity, you must create a new volume after you have replaced
the drive.
1. Access your Personal Cloud.

e PC—In Windows or File Explorer under Networks, click PersonalCloud.

® Mac—In Finder under Shared, click PersonalCloud.

p’ Note: If your computer does not detect your Personal Cloud, go to Seagate Support.

Open the Public folder and then double-click Personal Cloud.

Sign into your Personal Cloud 2-bay.

On the Summary page, click Manage.

Choose how to configure your device. Seagate recommends Maximum protection to protect your data if
one hard drive fails. While Maximum capacity allows you to use the total storage capacity, your data is
lost if a hard fails. Note: Since all your files are copied to both hard drives when using Maximum
protection, available storage is half the total capacity. For example, if your Personal Cloud 2-bay has 8TB
of storage capacity, you can store up to 4TB when using Maximum protection.

6. Choose Next.

Review the summary page and choose Finish.

8. Choose Yes to configure the device.

vk N

N
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App Manager

Use the App Manager to install and manage apps on your device. Apps give your device additional functions
and features. The App Manager includes apps that are Seagate branded as well as apps that are developed
by third parties specifically for Seagate network devices.

Overview

Review the list below to learn about the App Manager categories:
e My Apps: Your installed apps.
e Updates: Available updates for installed apps.
All: All available apps.
Backup: Apps used to back up your data.
Business: Apps used for commercial purposes.
Multimedia: Apps used for sorting your media.
Security: Antivirus apps.
Utilities: Utility apps.
Advanced: Install third party apps that are not available in the App Manager.

How to Install Apps

Follow the steps below to install an app.
1. From the Categories menu select a category.
2. Hover the cursor over the desired app and click Install.
3. Once the app is installed, a new button called Action is available. Click the button and select the action
you would like to perform from the drop down menu:
e Open: Opens the app so that you can use it.
e Details: Shows the app’s details and allows you to set permissions. Note: Third party apps provide
support details on this page.
e Stop: Stops the app. You must return to this option to turn it back on.
e Uninstall: Uninstalls the app.

Maintenance

Check for updates regularly in Maintenance.

1. Open App Manager.

2. Check Installed > Updates.

3. If one or more updates are available, a number appears next to Updates. The number represents the
number of updates that are available for the apps you have installed.

4. Click Updates to see a list of apps that are ready for updates.

5. Click the Update button that corresponds with the app you want to update.
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p’ Note: There are two buttons at the top right corner of the Updates screen, Check Apps and

Update all. Use Check Apps to check for updates. Use the Update all to update all your apps at
once. Update all can take some time to finish.

Advanced

The advanced section is used for installing third party apps and updates that are not available in the App
Manager. Follow the instructions below to use the advanced section.

p’ Note: Seagate does not provide support for third party apps. If you have trouble with a third
party app, contact the app’s vendor.

To install an app, review the instructions below. Note that apps must have been created specifically for NAS
OS and have the file extension .rbw.

Click Advanced.
Turn Manual install mode to ON.

Note the status of the Dependencies. They should be OK
Click Install.

Browse to the app you wish to install and accept the terms.

CAEESIR I .

p’ Note: The app file type must be .rbw.
6. Click Install.

Once the app has installed it is located under My Apps.

p’ Note: Seagate only provides support for Seagate branded apps. If you need support with a third
party app, contact the app manufacturer.
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Filebrowser

Use the Filebrowser app to view, share and manage your files on your Seagate storage device.
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¢ Shared links

(*) Seagate Media

You can:

Browse the media on your Personal Cloud.

Select and open files for viewing or playing.

Choose from Advanced Settings.?

Create folders and upload files to your Personal Cloud.

Switch between list/thumbnail views.?

View file and folder information.?

Share links to files with other people.Z

Manage your content: Download, copy, move, rename, and delete files and folders.

©NOGhk WD

Access your Personal Cloud

Access using a web browser (PC and Mac)

1. Open aweb browser and go to PersonalCloud.seagate.com.
2. Login with your email address and password.
3. Your NAS OS devices are listed. Click on the Personal Could you would like to access.

Access using Windows or File Explorer (PC only)

1. Open your File Explorer.
2. Under Networds, click PersonalCloud.
3. Open the Public folder, and then double-click PersonalCloud.
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4. Enter your Personal Cloud username and password.

Access using the Finder (Mac only)

1. Open aFinder window.

2. Under Shared, click PersonalCloud.

3. Click Connect As... .

4. Select Registered User.

5. Enter your Personal Cloud username and password.

Open the Filebrowser

1. Click the Apps icon, and then click on Filebrowser.

x

™)

Filebrowser

Create a Folder

1. Go to the destination folder for your files.
2. Click the Add icon gp on the top right and choose New Folder.

3. Enter a name for the new folder and click Save.

Upload files

1. Go to the destination folder for your files.
2. Click the Plus Sign on the top right and choose Upload.
3. Select the files you want to upload.
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4. Click Open.

Switch between list/thumbnail views

Files can be displayed in a list or with tiled thumbnails.
1. Click on the Thumbnailicon §& to switch to thumbnail view, or click on the List icon := to switch to list
view.

Share files

1. Navigate to the item you want to share.
2. Click Sharelink.You can:

® Email the link from the Filebrowser’s native email client or copy the link to your preferred email
client.

® Add apassword or expiration date by clicking Add password and expiration date.

p’ Note on the share link : The link to share a file or folder is created when you click Share link.
Even if you do not copy or send the link, it exists on the device. If you mistakenly created the
link or you do not want to keep it, click Remove the link in the Share link pop-up window.

Viewing or listening to files

You can view or listen to content in the Filebrowser app as long as your browser supports the file type.

Manage content

1. Select the file or folder you want to manage.
3. Click Actions.

3. The following actions are available:

e Download: Select Download to save the selected file or folder to a local drive, or to open the file
with another application.?

® Copy: Select Copy and navigate to another folder on your Personal Cloud. Select Copy here to paste
the copied item.

® Move: Select Move and navigate to another folder on your Personal Cloud. Select Move here to move
the item.

e Rename: Select Rename. A dialog box appears. Enter a new name for the item and click Save.?

e Delete: Select Delete. A dialog box appears. Click Delete to remove the item from your Personal
Cloud.

Ingest from an external drive
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1. Connect your external USB hard drive to one of the Personal Cloud's USB ports. Use the USB 3.0 port if
your hard drive supports USB 3.0.
2. Open Filebrowser.

3. The following message appears: External storage connected Copy to Seagate Personal Cloud. Click Copy

to Seagate Personal Cloud. Note: The name of the device can change based upon the name of your
Seagate storage device.
4. Select the folders and files you want to copy and click Copy.

v

Select the destination folder and click Copy.

6. Choose how you would like to manage file conflicts and click Save.

Advanced settings

Setting

Index
warning

popup

Popups for
external
storage

Show
hidden
files

Low
resolution
images

Show
information
panel

Seagate Personal Cloud 2-Bay

Description

When you make private content public, Seagate Media indexes files and updates the
access rights from private to public. This means that all users of your Personal Cloud and
anyone on your home network can access the indexed folders. When this setting is
activated, a message is displayed when the user makes the content public [link to this]
informing them that the selected private folder will be available to everyone who has
access to the device.

When activated, a message is displayed when an external storage device is connected to

your Personal Cloud device. You can then choose to copy files from the external device.

When activated, the user can view hidden files.

When activated, low resolution images are used as thumbnails in media galleries, improving
load times.

When activated, the information panel is displayed by default when you open the
Filebrowser app.
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Context

When activated, right-clicking on a file or folder brings up a contextual menu containing

menu content management actions.
& Download
2] Copy
— Move
# Rename
W Delete
Clear
transfers
button
Reload When activated, the file path displays a Reload button. Click the button to refresh the view
button of the current folder.
#& / Public / =
Seagate Personal Cloud 2-Bay 5/24/17
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Backup Manager

D,

Backup Manager

The Backup Manager has four options: Backup, Restore, Sync, and Network Backup server. Backup, Restore,
and Sync feature intuitive setup wizards.

Backup

Use Backup to perform the following types of backups:
® Back up your Seagate Personal Cloud to:
e External USB storage (USB hard drive or USB flash drive)
e Network storage (Seagate or third-party network storage)
® Cloud storage
® Back up external USB storage to your Seagate Personal Cloud (USB hard drive or USB flash drive).
e Back up network storage to your Seagate Personal Cloud (Seagate or third-party network storage).
® Back up cloud storage to your Seagate Personal Cloud.

Cloud services supported by Backup include:
e Amazon S3

Baidu

Box

Dropbox

Google Drive

Strato HiDrive

Yandex.disk
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e OneDirive

I Note on computer backups: You can back up your computers to the Seagate Personal Cloud.
Backup applications such as Seagate Dashboard (Windows), Windows File History and Apple
Time Machine manage how the computer backups are performed. Use your preferred backup
application and choose a shared folder on your Seagate Personal Cloud as the destination for the
computer backup. When performing a backup to a private share, make certain that a user can
access the share. For more information, see Back up.

Restore

Restore a backup that has been performed on the Backup page.

Sync

Choose one or more folders on your Seagate Personal Cloud to sync with your cloud storage account. Cloud
services supported by Sync include:

e Baidu

e Dropbox

e Google Drive

e OneDrive

Network Backup disk

Enable Network Backup so that other Seagate Personal Cloud or Seagate network storage devices can back
up to your primary Seagate Personal Cloud.

Important info on backups: It is recommended that all users back up data to a USB storage
device, another network storage device or cloud storage as further protection against a missing
hard drive or secondary points of failure (e.g. hardware, network, etc.)

ol s

& Note on backup job order: To conserve processing resources, the Seagate Personal Cloud runs
one job at time. If more than one job is scheduled for the same time or started manually, Backup
Manager places them in a queue.

Backup, Sync, and Restore examples

Back up to a USB storage device
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An owner keeps important files on her private share. Since remote access is not always available when she
travels, the owner backs up her share to a portable USB storage device.

Back up to a Seagate network storage device on the home network

To prevent data loss due to hardware failure, the owner schedules regular backups of Seagate Personal Cloud
1 to Seagate Personal Cloud 2. They are both on the same local network. Alternatively, the administrator can
back up Seagate Personal Cloud 1 to a compatible third-party network storage device.

Back up to a network storage device outside the local network (offsite)

To prevent data loss due to onsite fire, flood, or theft, the owner backs up data on Seagate Personal Cloud 1
at her home to Seagate Personal Cloud 2 at a her brother's home. A compatible third-party storage device
can also act as the destination storage.

Back up to a cloud service

To prevent data loss due to onsite fire, flood, or theft, the owner backs up data on Seagate Personal Cloud 1
to her OneDrive account.

Restore

Someone at home accidentally deleted an important spreadsheet from his personal share. Fortunately, the
owner backs up to another storage solution, such as USB storage, another Seagate network storage device or
cloud storage. The owner can:
® Restore a backup to revert the share to an earlier state, including the lost file.
e Connect to the destination storage device from a computer and browse for the missing file. For
example, retrieve the file from a cloud storage service that hosts a Personal Cloud backup.

Important info: The time to complete the first backup job can vary based upon the amount of
data and the speed of your network. It can take several hours or, if it is an offsite or cloud
backup, several days.

Create a backup

To create a backup:

1. Launch the Backup Manager app

2. Choose Backup.

3. Click Add backup to launch the Backup Wizard.

Follow the Backup Wizard to perform one of the following types of backup:
® Back up your Seagate Personal Cloud to:
e External storage (USB hard drive or USB flash drive)
e Network storage (Seagate or third-party network storage)
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® Cloud storage
e Back up external storage to your Seagate Personal Cloud (USB hard drive or USB flash drive).
e Back up network storage to your Seagate Personal Cloud (Seagate or third-party).
® Back up cloud storage to your Seagate Personal Cloud.

Review the topics below to better understand the settings and requirements for the type of backup you
want to perform.

Back up using USB storage

Perform the following types of backups with USB storage connected to your Seagate Personal Cloud:
e Seagate Personal Cloud to USB storage.
e USB storage to Seagate Personal Cloud.

You can optimize backups to and from a USB storage device connected to one of the USB ports on your
Seagate Personal Cloud. Refer to the table below for the file formats that work best with your Seagate
device. When configuring a backup with a USB device, the Backup Wizard gives you the option to format
your USB storage for optimized backups. By using the optimized formats, you have the option to perform
incremental backups.

An incremental backup allows you to back up new or modified files following the first backup. If the format is
not optimized, you must perform full backups each time ajob is run. A full backup copies everything on the
source each time the backup is run.

Operating systems Hard disk file system Optimized backup (incremental)
Linux EXT2, EXT 3, EXT 4, and XFS Yes
Mac HFS+ Non-Journaled Yes
Mac HFS+ Journaled No
Windows/Mac FAT32 No
Windows NTFS No

Back up using network storage

Perform the following types of backups with a second Seagate Personal Cloud, another Seagate network
storage device or a third-party network storage device:
® The primary Seagate Personal Cloud to a second Seagate Personal Cloud, another Seagate network
storage device or third-party network storage device.
® A second Seagate Personal Cloud, another Seagate network storage device or third-party network
storage device to the primary Seagate Personal Cloud.
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The second Seagate Personal Cloud, Seagate network storage device or third-party network storage device
can be located on the same network as the primary Seagate Personal Cloud or, on a network at a different
location (offsite).

Backups between Seagate Personal Cloud and other network
storage devices

Backups to and from your Personal Cloud and other Seagate network storage devices require a unique

destination share called

server.

Backups to and from your Seagate Personal Cloud and a third-party network device can use an existing

shared folder.

For example, the owner wants to back up shares on Seagate Personal Cloud A to Seagate Personal Cloud B.
Seagate Personal Cloud A is the source network device and Seagate Personal Cloud B is the destination
network device. To receive the backup data from Seagate Personal Cloud A, the destination device,
Seagate Personal Cloud B, must enable its Network Backup server. Refer to the table below for examples of
backups to and from Seagate and third-party network devices.

Type of
network
backup

Backup to a
Seagate
network
storage
device

Backup to a
third-party
network
storage
device

Backup
from a
third-party
network
storage
device

Source device

Seagate Device A on the local network

Seagate Device on the local network.

Third-party network device on the local
or remote network (offsite). The device’s
shared folders must support a
compatible network protocol (see
below).

Enable Network Backup server

Destination
device

Seagate Device

B on the local or
remote network
(offsite).

Third-party
network device
on the local or
remote network
(offsite).

Seagate Device
on the local
network.

Destination folder

Network Backup server

Shared folder on the third-
party network device that
supports a compatible
network protocol (see
below).

Shared folder on the
Seagate network device.

Before configuring network backups between Seagate devices, the administrator must enable the Network
Backup server on the destination device.

1. Go to Backup Manager > Network Backup server.
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Choose Enable.

At the prompt, enter and confirm a password. The password can be different from the password you
use for your Seagate Access sign-in (between 4 and 20 characters). Your Network Backup password will
be needed when you set up a network backup.

Choose Save.

Network Backup server settings

The Network Backup server table provides a summary of its settings. You can return to the Network Backup
server page if you forget the password or you want to disable it.

Only the administrator can access the Network Backup server settings.
The administrator can find the Network Backup password if it is forgotten. Go to Backup Manager >
Network Backup server and click on the magnifying glass icon.
To change the Network Backup server password, pass the cursor to the right of the asterisks and choose
the configuration icon (pencil).
For offsite backups, administrators must confirm that the ports used by Personal Cloud backup jobs are
available on the network router. The default port numbers are:

e Port22

e Port 873 (encrypted backups)
To delete the Network Backup server, choose Disable. A prompt will ask if you wish to keep data or
delete all files within the share.

Backups with third-party network storage

The Backup Wizard can help you create backups to and from third-party network storage devices that
support the following protocols:

Rsync

SMB

FTP

NFS

WebDav (Web Distributed Authoring and Versioning)

Backups to network storage devices

Home or local network

When performing network backups on a local network, make certain that:

The source and destination network devices are powered on.

The destination network storage device is connected to the same network as your source device.
(Seagate network storage) The Network Backup server has been enabled and you have the password.
(Third-party network storage) The third-party network device supports one of the five network protocols
listed above.

(Third-party network storage) You have noted the third-party network device’s IP address or network
name. Network naming services are not as reliable as IP addressing.

(Third-party network storage) You have the username and password for the network device’s backup
service.
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Similar to Seagate network devices, many third-party network devices have separate credentials for login
and backup.

Remote network

When performing network backups to a remote network, make certain that:

e The source and destination network devices are powered on.

® You have the network device’s public IP address. You can find the public IP address by visiting
http://www.whatismyip.com/ or by accessing your remote network’s router management software.
When searching for the public IP address, use a computer connected to the same router as the
destination network storage device. For further information, review the user manual for the offsite
network router or contact your Internet service provider.

® The ports are open for the backup. You may need to open ports using your router's management
software. The ports to open are listed at Backup Manager > Network Backup server. Review your
router’s user manual for instructions on how to open ports for a device on the network.

e (Seagate network storage) The Network Backup server has been enabled on the destination device and
you have the password.

e (Third-party network storage) The third-party network storage device supports one of the five network
protocols listed above.

e (Third-party network storage) You have the username and password for the network device's backup
service. Similar to Seagate network devices, many third-party network devices have separate credentials
for login and backup.

Advanced parameters for backups to network storage devices

The Backup Wizard includes four options for your backup. See the explanations below for each option. It is
not mandatory to select one or more of the parameters to continue with the backup:
° uses encryption during the data transfer. The data is not encrypted once itis
stored on the destination. This option is ideal for offsite backups.

° a transfer optimizes data transmission rates. Data is compressed during the
transfer only. While this option is good for low bandwidth networks, it can affect the Personal Cloud's
performance.

° is best used with backups that include files larger than 50MB. For

example, if you edit a document that has already been backed up, only the edits will be copied during
the next backup. This option can affect the Personal Cloud's performance.

° keeps files on the destination network device even if they are
deleted from the original network device's source folder.

Back up using cloud storage

Before performing a backup to or from cloud storage, make certain:
® You have an account with one of the following services:

e Amazon S3

e Baidu

® Box

e Dropbox
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Google Drive
Strato HiDrive
Yandex.disk
® OneDrive
® You have the necessary login and access credentials for your account. You cannot create a backup
without your credentials.

Advanced parameters for backups to cloud storage

The Backup Wizard includes one or more options for your backup. See the explanations below. It is not
mandatory to select one or more options to continue with the backup:
° uses encryption during the data transfer. The data is not encrypted once itis
stored on the destination. This option is ideal for offsite backups.
° keeps files on the destination even if they are deleted from
the source's folder.

Sync folders

Use Sync to keep data in one or more folders on your Seagate Personal Cloud consistent with a folderin a
cloud storage service. For example, you run a Sync job for Folder A on your Seagate Personal Cloud. It has 25
files when the Sync job is first created with a similarly named folder on OneDrive. Soon after, you copy file
26 to Folder A on your Seagate Personal Cloud. The same file 26 is automatically uploaded to OneDrive to
keep both folders in sync. You can also add files to the folder on OneDrive and they will automatically sync
with Folder A.

Before performing a sync to cloud storage, make certain:

® You have an account with one of the following services:
e Baidu
e Dropbox
e Google Drive
® OneDrive

® You have the necessary login and access credentials for your account. You cannot create a sync without
your credentials.

Create a sync:

1. Launch the Backup Manager app.
2. Choose Sync.
3. Click Add sync job to launch the Sync Wizard and follow it to completion.

Restore a backup

Backups to or from your Seagate Personal Cloud can be restored. You can restore a backup to the original
source folder or choose another folder for your backed up files. Follow the directions below to restore a
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backup.

1. Launch the Backup Manager app.

2. Choose Restore.

3. Click Add restore to launch the Restore Wizard and follow it to completion.

Backup and sync job options and start/stop
Options

Follow the steps below to review and change options for a backup or sync job.

1. Launch the Backup Manager app.

2. For backups, locate the backup you want to modify then pass the cursor to the far right of its row to
enable the Edit pull-down menu.

3. Forsync jobs, click Sync and locate the sync you want to modify then pass the cursor to the far right of
its row to enable the Edit pull-down menu.

4. You can choose:

e Details

Enable/Disable the OneTouch button (if applicable)

Edit authentication

Edit description

Edit schedule

Disable

Restore

Delete

If you disable a scheduled job, it will not run until it is enabled again.

Starting/stopping jobs

Locate the backup or sync job you want to stop or start and pass the cursor to the far right of its row to view
the triangular and square icons:

e Start ajob: choose the triangular icon.

e Stop ajob thatis in progress: choose the square icon.
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Appendix A: Compliance and Safety

Regulatory Compliance
FCC DECLARATION OF CONFORMANCE

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

FCC Class B Information

FCC Class B Information

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful inter-ference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one of the following measures:

e Reorient or relocate the receiving antenna.

® Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate this equipment.

IMPORTANT NOTE: FCC Radiation Exposure Statement

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled envi-ronment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your
body.
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This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The availability of some specific channels and/or operational frequency bands are country de-pendent and
are firmware programmed at the factory to match the intended destination. The firmware setting is not
accessible by the end user.

Note to US model owner: To comply with US FCC regulation, the country selection function has been
completely removed from all US models. The above function is for non-US models only.

Industry Canada

This device complies with RSS-210 of the Industry Canada Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired opera-tion.

Ce dispositif est conforme a la norme CNR-210 d'Industrie Canada applicable aux appareils radio exempts
de licence. Son fonctionnement est sujet aux deux conditions suivantes: (1) le dispositif ne doit pas
produire de brouillage préjudiciable, et (2) ce dispositif doit accepter tout brouillage recu, y compris un
brouillage susceptible de provoquer un fonctionnement indésirable.

IMPORTANT NOTE: (For mobile device use)
Radiation Exposure Statement:

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your
body.

NOTE IMPORTANTE: (Pour l'utilisation de dispositifs mobiles)
Déclaration d'exposition aux radiations:

Cet équipement est conforme aux limites d'exposition aux rayonnements IC établies pour un
environnement non controlé. Cet équipement doit étre installé et utilisé avec un minimum de 20 cm de
distance entre la source de rayonnement et votre corps.

Europe - EU Declaration of Conformity

This device complies with the essential requirements of the EMC Directive 2004/108/EC. The following test

methods have been applied in order to prove presumption of conformity with the essential requirements
of the EMC Directive 2004/108/EC:
e EN 60950-1:2006/AC:2011: Information technology equipment - Safety - Part 1: General requirements
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e EN 55022: 2010/AC:2011: Information technology equipment - Radio disturbance characteristics

® Limits and methods of measurement

e EN 55024: 2010: Information technology equipment - Immunity characteristics - Limits and methods of
measurement

Cesky
[Czech]

Dansk
[Danish]

Deutsch
[German]
Eesti
[Estonian]
English

Espanol
[Spanish]

EAMNVIKNA
[Greek]

Francais
[French]

[taliano
[Italian]

Latviski
[Latvian]

Seagate timto prohlasuje Ze tento Desktop NAS je ve shodé se zakladnimi poZadavky a
dalSimi prislusnymi ustanovenimi smérnice 2004/5/ES.

Undertegnede Seagate erklaerer herved at fglgende udstyr Desktop NAS overholder de
vaesentlige krav og gvrige relevante krav i direktiv 2004/5/EF.

Hiermit erklart Seagate, dass sich das Gerat Desktop NAS in Ubereinstimmung mit den
grundlegenden Anforderungen und den Gbrigen einschldgigen Bestimmungen der Richtlinie
2004/5/EG befindet.

Kiesolevaga kinnitab Seagate seadme Desktop NAS vastavust direktiivi 2004/5/EU
pohinduetele ja nimetatud direktiivist tule-nevatele teistele asjakohastele satetele.

Hereby, Seagate, declares that this Desktop NAS is in compliance with the essential
requirements and other relevant provisions of Directive 2004/5/EC.

Por medio de la presente Seagate declara que el Desktop NAS cumple con los requisitos
esenciales y cualesquiera otras dispo-siciones aplicables o exigibles de la Directiva
2004/5/CE.

ME THN MNAPOYZA Seagate AHAQNEI OTI Desktop NAS XYMMOP®QNETAI MPOX TIZ
OYZIQAEIZ AMAITHXEIX KAI TIZ AOITEXZ ZXETIKEX AIATAZEIX THX OAHI'IAZ
2004/5/EK.

Par la présente Seagate déclare que l'appareil Desktop NAS est conforme aux exigences
essentielles et aux autres dispo-sitions pertinentes de la directive 2004/5/CE.

Con la presente Seagate dichiara che questo Desktop NAS & conforme ai requisiti essenziali
ed alle altre disposizioni per-tinenti stabilite dalla direttiva 2004/5/CE.

Ar So Seagate deklare, ka Desktop NAS atbilst Direktivas 2004/104/EK butiskajam prastbam
un citiem ar to saistitajiem noteikumiem.
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Lietuviy Siuo Seagate deklaruoja, kad $is Desktop NAS atitinka esmi-nius reikalavimus ir kitas
[Lithua- 2004/104/EB Direktyvos nuosta-tas.

nian]

Nederlands Hierbij verklaart Seagate dat het toestel Desktop NAS in overeenstemming is met de
[Dutch] essentiéle eisen en de andere relevante bepalingen van richtlijn 2004/104/EG.

Malti Hawnhekk, Seagate, jiddikjara li dan Desktop NAS jikkon-forma mal-htigijiet essenzjali u ma
[Maltese] provvedimenti ohrajn relevanti li hemm fid-Dirrettiva 2004/104/EC.

Magyar Alulirott, Seagate nyilatkozom, hogy a Desktop NAS megfelel a vonatkozé alapveto

[Hungarian]

kovetelményeknek és az 2004/104/EC iranyelv egyéb elbirdsainak.

Polski Niniejszym Seagate o$wiadcza, ze Desktop NAS jest zgodny z zasadniczymi wymogami oraz
[Polish] pozostatymi stosownymi postanowieniami Dyrektywy 2004/104/EC.

Portugués Seagate declara que este Desktop NAS estd conforme com os requisitos essenciais e
[Portu- outras disposicdes da Directiva 2004/104/CE.

guese]

Slovensko Seagate izjavlja, da je ta Desktop NAS v skladu z bistvenimi zahtevami in ostalimi
[Slove- relevantnimi dolocili direktive 2004/104/ES.

nian]

Slovensky Seagate tymto vyhlasuje, Ze Desktop NAS spliia zakladné poziadavky a vietky prisluiné
[Slovak] ustanovenia Smernice 2004/104/ES.

Suomi Seagate vakuuttaa titen ettd Desktop NAS tyyppinen laite on direktiivin 2004/104/EY
[Finnish] oleellisten vaatimusten ja sitd koskevien direktiivin muiden ehtojen mukainen.
Svenska Hirmed intygar Seagate att denna Desktop NAS star | 6ve-rensstimmelse med de
[Swedish] vasentliga egenskapskrav och dvriga relevanta bestammelser som framgar av direktiv

2004/104/EG.

Safety Guidelines

Important info: Refer to Warranty before performing any hardware repairs or maintenance that
is not described in this manual.

Power Source

| Caution: Use the product with the provided power supply only.

& Note: To protect your data, always follow the safe removal procedures for your operating
system when disconnecting your product.

Seagate Personal Cloud 2-Bay 5/24/17 67


http://www.seagate.com/support/warranty-and-replacements/limited-consumer-warranty

Safety Handling

To comply with applicable safety, emission, and thermal requirements, install all drives and empty drive
trays according to the instructions in Hard Drive Maintenance.

Permanently unplug the unit if you think that it has become damaged in any way.

You must shut down and disconnect power from the Personal Cloud 2-Bay before maintenance or physical
troubleshooting is performed on the device.
Shut down and unplug the unit before moving it.

Safety
Power Supply

The Personal Cloud 2-Bay must only be operated from a power supply input voltage range of 100 - 240 VAC,
50 to 60 Hz.

The drive’s power supply is not serviceable or replaceable. If Seagate technical support has determined that
the power supply is faulty or has failed and the unit is under warranty, return the Personal Cloud 2-Bay to
Seagate per the instructions provided by the Seagate technician.

Environment

Make sure that the electrical connection to the power cord is grounded.

Provide a suitable power source with electrical overload protection to meet the requirements of the
technical specification.

Never expose your device to rain, use it near water, or use it in damp or wet conditions. Never place
objects containing liquids on the enclosure, because liquid could spill into its openings. Doing so increases
the risk of electrical shock, short-circuiting, fire, or personal injury.

Always unplug the device from the electrical outlet if there is a risk of lightning or if it will be unused for an
extended period of time.

Do not use the Personal Cloud 2-Bay as a shelf to support any other object.

Personal Cloud 2-Bay Placement

Place your Personal Cloud 2-Bay on a surface that is capable of supporting its weight, including the hard
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drives and accessories attached to the Personal Cloud 2-Bay ports. Make sure the Personal Cloud 2-Bay is
placed securely and cannot tip or be pushed over. Do not stack items on it. Doing so can prevent proper
airflow and affect operation.

The maximum ambient temperature during operation is 40°C or 104°F.
The power connection must have a safe electrical distribution system and provide overcurrent protection.

The power supply unit has a ground leakage current of 3.5mA. The design of the electrical distribution
system must take into consideration the total ground leakage current from all the power supplies in all the
units.

Data Security

Any loss, corruption, or destruction of data while using a Seagate hard drive or a hard drive system is the
sole responsibility of the user. Under no circumstances will Seagate be held liable for the recovery or
restoration of this data. To help prevent the loss of your data, Seagate highly recommends that you keep
TWO copies of your data: one copy on your Personal Cloud 2-Bay, and a second copy on one of the
following:

e Direct-attached storage (DAS)

e Another NAS device

® Cloud storage

e Some form of removable storage or archival media

Important: 1GB = 1,000,000,000 bytes. 1TB = 1,000,000,000,000 bytes. After the drive is
formatted, the available storage capacity varies depending on your operating environment
(typically 10%-15% less).
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